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Chapter 106

Conditional Power and
Sample Size
Reestimation of NonInferiority Tests for One
Proportion
Introduction
In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the
experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to
evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional
power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to
the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power
over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment
techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow
and Chang (2007), Chang (2008), Proschan et. al (2006), and Dmitrienko et. al (2005).
This program module computes conditional and predicted power for the case when a one-sample z-test is used to test
whether a population proportion is greater than or less than a specific non-inferiority bound. It also provides sample
size reestimation to achieve a specified conditional power value.

Technical Details
All details and assumptions usually made when using a one-sample non-inferiority z-test continue to be in force
here.

Conditional Power
The power of an experiment indicates whether a study is likely to result in useful results, given the sample size.
Low power means that the study is futile: little chance of statistical significance even though the alternative
hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the
study has started. When this happens, the study is curtailed.
The futility of a study that is underway can be determined by calculating its conditional power: the probability of
statistical significance at the completion of the study given the data obtained so far.
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It is important to note that conditional power at the beginning of the study before any data are collected is equal to
the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional
power will seldom result in study curtailment very early in the study.
From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage k for
rejecting a null hypothesis about a parameter θ at the end of the study, given the observed test statistic, Z k , is
computed as

 Z I − z1−α I K + θ (I K − I k ) 
,
Puk (θ ) = Φ  k k


I
I
−
K
k


and the general lower one-sided conditional power at stage k is computed as

 − Z k I k − z1−α I K − θ (I K − I k ) 
,
Plk (θ ) = Φ 


IK − Ik


where

θ = the parameter being tested by the hypothesis
k = an interim stage at which the conditional power is computed (k = 1, …, K – 1)
K = the stage at which the study is terminated and the final test computed

Z k = the test statistic calculated from the observed data that has been collected up to stage k
I k = the information level at stage k
I K = the information level at the end of the study

z1−α = the standard normal value for the test with a type I error rate of α.
If we define 𝑃𝑃𝑠𝑠 as the population reference, standard, or baseline proportion, NIM as the non-inferiority margin,
and 𝑃𝑃1 as the actual proportion under the alternative hypothesis, then the parameter 𝜃𝜃 to test the one-sided noninferiority alternative hypotheses of 𝐻𝐻1 : 𝑃𝑃 > 𝑃𝑃0 (higher proportions better with 𝑃𝑃0 = 𝑃𝑃𝑠𝑠 − |𝑁𝑁𝑁𝑁𝑁𝑁|) or 𝐻𝐻1 : 𝑃𝑃 < 𝑃𝑃0
(higher proportions worse with 𝑃𝑃0 = 𝑃𝑃𝑠𝑠 + |𝑁𝑁𝑁𝑁𝑁𝑁|) and other conditional power calculation components as
outlined in Chang (2008) page 70 are

θ = P1 − P0 (the expected difference under the alternative hypothesis)

𝑍𝑍𝑘𝑘 = (𝑝𝑝𝑘𝑘 − 𝑃𝑃0 )�𝐼𝐼̂𝑘𝑘

(the z-statistic computed from the observed data)

I k = nk / σ 2 (the interim information level)
I K = N / σ 2 (the final information level)

where
𝑝𝑝𝑘𝑘 is the sample proportion, estimating P1 at stage k

Iˆk is the estimated information from the sample at stage k

nk is the sample size at stage k

N is the total sample size

σ 2 = p (1 − p ) with p = (P1 + P0 ) / 2 .
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Computing conditional power requires you to set P0 and P1 . Their values can come from the values used during
the planning of the study, from similar studies, or from estimates made from the data that has emerged.

Futility Index
The futility index is 1 − 𝑃𝑃𝑘𝑘 (𝜃𝜃)|𝐻𝐻1. The study may be stopped if this index is above 0.8 or 0.9 (that is, if
conditional power falls below 0.2 or 0.1).

Predictive Power
Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution
of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power
at stage k is given by

 Z I − z1−α I k 
,
Puk = Φ  k K


I
I
−
K
k


and the general lower one-sided predictive power at stage k is given by

 − Z k I K − z1−α I k 
,
Plk = Φ 


I
I
−
K
k


with all terms defined as in the equations for conditional power.

Sample Size Reestimation
As Chang (2014) points out, after an interim analysis, it is often desirable to recalculate the target sample size using
updated values for various nuisance parameters such as the variance. This process is known as sample size
reestimation.
One method of calculating an adjusted sample size estimate is to search for the sample size that results in a
predetermined value of conditional power. PASS conducts a binary search using the conditional power as the
criterion. The result is called the target sample size.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Conditional Power or Sample Size Reestimation.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate conditional power directly. To find appropriate values of sample size, a binary
search is made using an iterative procedure until an appropriate value is found.

Test
Higher Proportions Are
Use this option to specify the direction of the non-inferiority test.
If Higher Proportions are “Better”, the alternative hypothesis is H1: P > P0.
If Higher Proportions are “Worse”, the alternative hypothesis is H1: P < P0.

Conditional Power and Alpha
Conditional Power
Enter one or more values for the conditional power that is to be attained by the sample size search.
Conditional power is the probability of rejecting a false null hypothesis given the data that has been obtained so
far. It is a function of the effect size and the data that have been collected.
The valid range is between 0 to 1. Typically, values over 0.70 are considered high enough to continue a study,
while values below 0.10 considered grounds for curtailing the study.
You can enter a single value such as 0.80 or a series of values such as 0.80 0.85 0.90 0.95 or 0.7 to 0.97 by 0.05.
Alpha
This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error
occurs when a true null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025
for one-sided tests.
You may enter a single value or a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size
N (Target Sample Size)
This option specifies one or more values of the target sample size, the total number of subjects planned for the
study. This value must be an integer greater than one. Note that you may enter a list of values using the syntax
50,100,150,200,250 or 50 to 250 by 50.
nk (Sample Size at Look k)
Enter the sample size obtained through look k. If this value is greater than N, the value of N is increased to this
amount.

Effect Size – Proportions
P0 (Non-Inferiority Proportion)
This is the bound of the non-inferiority test hypothesis.
If NIM is the non-inferiority margin and Ps is the reference, standard, or baseline proportion, then when Higher
Proportions are “Better”, the alternative hypothesis is H1: P > P0, with P0 = Ps - |NIM| and P0 < P1. When
Higher Proportions are “Worse”, the alternative hypothesis is H1: P < P0, with P0 = Ps + |NIM| and P0 > P1.
P1 (Actual Proportion to Detect)
This is the actual proportion at which conditional power is calculated. Care should be taken that this value is
consistent with the alternative hypothesis.
When Higher Proportions are “Better”, P1 > P0. When Higher Proportions are “Worse”, P1 < P0.

Effect Size – Current Test Statistic
Zk (Current Test Statistic)
Enter the value of the z-statistic calculated from the data obtained through stage k. This value may be positive or
negative. Typically, the z-statistic ranges between -5 and 5.
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Example 1 – Computing Conditional Power
Suppose a study has been planned and is to be analyzed using a one-sided non-inferiority z-test at an alpha of
0.025. The reference proportion is known to be 0.6 and the test will have a non-inferiority margin of 0.05. The test
will have a lower bound of P0 = Ps – NIM = 0.6 – 0.05 = 0.55. They would like to compute conditional power for
an actual proportion of P1 = 0.65. The sample size is 50. An interim analysis will be run after half the data have
been collected.
The data monitoring board would like to have the conditional power calculated for z-values of 1.0, 1.5, 2.0, 2.5,
and 3.0.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 1
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Conditional Power
Higher Proportions Are ........................... Better (H1: P > P0)
Alpha ....................................................... 0.025
N (Target Sample Size) .......................... 50
nk (Sample Size at Look k) ..................... 25
P0 (Non-Inferiority Proportion) ................ 0.55
P1 (Actual Proportion to Detect) ............. 0.65
Zk (Current Test Statistic) ....................... 1 1.5 2 2.5 3

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample Z-Test ─────────────────────────────────────────────
Hypotheses: H0: P ≤ P0 vs. H1: P > P0

Cond.
Power
0.22627
0.40083
0.59825
0.77302
0.89413

Pred.
Power
0.29262
0.56409
0.80743
0.94244
0.98878

Target Current
Sample Sample Non-Inf
Size
Size
Prop
N
nk
P0
50
25
0.550
50
25
0.550
50
25
0.550
50
25
0.550
50
25
0.550

Actual
Prop
P1
0.650
0.650
0.650
0.650
0.650

Diff
P1-P0
0.100
0.100
0.100
0.100
0.100

Test
Statistic
Zk
1.000
1.500
2.000
2.500
3.000

Alpha
0.025
0.025
0.025
0.025
0.025

Futility
0.77373
0.59917
0.40175
0.22698
0.10587

References
Jennison, C., and Turnbull, B.W. 2000. Group Sequential Methods with Applications to Clinical Trials. Chapman &
Hall/CRC. New York.
Proschan, M., Lan, K.K.G., Wittes, J.T. 2006. Statistical Monitoring of Clinical Trials. Springer. New York.
Chang, Mark. 2008. Classical and Adaptive Clinical Trial Designs. John Wiley & Sons. Hoboken, New Jersey.
Chang, Mark. 2014. Adaptive Design Theory and Implementation Using SAS and R. CRC Press. New York.
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Report Definitions
Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the data that
have emerged so far.
Predictive Power is the result of averaging the conditional power over the posterior distribution of the effect size.
N is the target sample size.
nk is the sample size obtained through stage k.
P0 is the non-inferiority proportion used to construct the hypotheses.
P1 is the actual proportion to detect under the alternative hypothesis at which conditional power is calculated.
P1-P0 is the proportion difference that is to be detected by the completed study.
Zk is the value of the test statistic from the observed data at stage k.
Alpha is the probability of rejecting a true null hypothesis.
Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be stopped
because there is little chance of achieving statistical significance.
Summary Statements ─────────────────────────────────────────────────────────
The first 25 of the planned 50 subjects achieve 22.627% conditional power to detect a difference of P1 - P0 =
0.100 using a non-inferiority z-test with a bound of μ0 = 0.550, an actual proportion of μ1 = 0.650, and a
significance level of 0.025. The z-value of the data that have emerged so far is 1.000. The futility index is
0.77373.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are
given in the Report Definitions section.

Plots Section

This plot shows the relationship between conditional power and Zk.
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Example 2 – Validation
We could not find an example of a conditional power calculation for a one-sample non-inferiority test in the
literature. Since the calculations are relatively simple, we will validate the calculation of the third scenario of
Example 1 (Zk = 2) by hand.
In this case

IK = N /σ 2

I k = nk / σ 2
25
0.6(1 − 0.6)
= 104.1666667
=

50
0.6(1 − 0.6)
= 208.3333333
=

 Z I − z1−α I K + θ (I K − I k ) 

Puk (θ ) = Φ  k k


−
I
I
K
k


 2.0 104.1666667 − (1.959964 ) 208.3333333 + (0.65 − 0.55)(208.3333333 − 104.1666667 ) 

= Φ 

−
208
.
3333333
104
.
1666667


 2.5394376 
= Φ

 10.2062073 
= Φ (0.2488131)
= 0.5982473

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 2
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Conditional Power
Higher Proportions Are ........................... Better (H1: P > P0)
Alpha ....................................................... 0.025
N (Target Sample Size) .......................... 50
nk (Sample Size at Look k) ..................... 25
P0 (Non-Inferiority Proportion) ................ 0.55
P1 (Actual Proportion to Detect) ............. 0.65
Zk (Current Test Statistic) ....................... 2

106-8
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Conditional Power and Sample Size Reestimation of Non-Inferiority Tests for One Proportion

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample Z-Test ─────────────────────────────────────────────
Hypotheses: H0: P ≤ P0 vs. H1: P > P0

Cond.
Power
0.59825

Target Current
Sample Sample Non-Inf
Pred.
Size
Size
Prop
Power
N
nk
P0
0.80743
50
25
0.550

Actual
Prop
P1
0.650

Diff
P1-P0
0.100

Test
Statistic
Zk
2.000

Alpha
0.025

Futility
0.40175

The conditional power of 0.59825 matches the value calculated by hand.
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Example 3 – Sample Size Reestimation
Suppose a study has started that is to be analyzed using a one-sided non-inferiority z-test at an alpha of 0.025. The
reference proportion was set at 0.6 and the non-inferiority margin was set at 0.05. The target sample size was 50.
An interim analysis was run after half the data had been collected. This analysis yielded a z-test value of 2.12. The
value of the baseline proportion was estimated at 0.637, so we set P0 to 0.637 – 0.05 = 0.587.
The data monitoring board would like to have the sample size reestimated for an actual difference of δ1 = 0.1 (P1
= 0.687) and a conditional power of 0.8.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 3
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size Reestimation
Higher Proportions Are ........................... Better (H1: P > P0)
Conditional Power................................... 0.8
Alpha ....................................................... 0.025
nk (Sample Size at Look k) ..................... 25
P0 (Non-Inferiority Proportion) ................ 0.587
P1 (Actual Proportion to Detect) ............. 0.687
Zk (Current Test Statistic) ....................... 2.12

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample Z-Test ─────────────────────────────────────────────
Hypotheses: H0: P ≤ P0 vs. H1: P > P0

Cond.
Power
0.80091

Target Current
Sample Sample Non-Inf
Pred.
Size
Size
Prop
Power
N
nk
P0
0.91177
111
25
0.587

Actual
Prop
P1
0.687

Diff
P1-P0
0.100

Test
Statistic
Zk
2.120

Alpha
0.025

Futility
0.19909

Notice that the target sample size has increased from 50 to 111.
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